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Core Training 

Logging into ECS 
1. Double-click the ECS icon to bring up the ECS Authorization Screen. 

2. Enter your login name and password. 

3. Enter a Delay Login for this session, if desired. (See below for details.) 

4. Click Login. 

5. Alternate Login: If the computer you are using has a fingerprint reader on it, you may 

scan your fingerprint rather than entering your login name and password. 

6. Once logged into the system, verify your name in the bottom toolbar in ECS as this is 

going to serve as your legal signature on all your documentation. 

Authorization Screen 

 
 

• This is the screen that appears after you double -click the ECS icon. 

• The  icon brings up a keyboard (if needed). 

• Click the Licensing Information link to find your Build or version number, as well as 

contact information for American Data’s customer support. 

Password  
• Each user will be assigned a password that will need to be changed upon initial login. 

• Users must select a password that is a minimum of 6 characters long and contain at 

least one number or letter based on system settings.  
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• Users may be required to change their password at regular intervals. 

• A fingerprint reader may be used in place of a password. 

• Your login and password should never be shared to ensure your electronic signature 

remains secure. 

Changing your Password 

• You may be prompted to change your password upon logging into ECS. This may 

occur if you were given a generic password when your profile was created. Or, your 

ECS may be set to require a password change at regular intervals. 

• When you log into ECS on the Authorization Screen, the Change Password screen will 

appear. You will be required to complete 3 fields: Old Password, New Password, and 

Confirm New Password. Enter your current password (the one you just used to log in) 

into the Old Password field. Decide on a new password (at least 6 characters long) and 

enter it into the New Password field. Enter the new password one more time into the 

Confirm New Password field. Then, click OK to confirm changes. 

• Your login name does not change when you change your password. 

Delay Login 
• This field appears on the Authorization Screen. 

• This is useful if you are using an ECS application that is set to automatically lock you out 

after a brief time, by allowing you to use the shorter password to log back in. 

• You may enter an abbreviated password (i.e., if your password is 123456789, you may 

enter a 1- or 2-digit password, such as 19). 

• Delayed logins are valid for the current ECS session only. The delay login must be reset 

each time you log into ECS. 

Fingerprint Authorization 
• This is optional in most states but mandatory in Ohio for completing electronic 

Medication Pass.  

• If your duties require use of fingerprint authorization in ECS, you will be required to 

scan your fingerprint when your user profile is set up. 

• When prompted to enter fingerprint authorization, place your fingertip on the scanner. 

• Your fingerprint may be used to log into ECS in place of a login/password. 

Electronic Signatures 
• Each entry you create in ECS is tagged with “identifiers.” These include the date of the 

entry, the time of the entry, and the name, title, and initials of the user logged into the 

session. 

• Electronic Signatures are legally binding and serve the same purpose as a manual 

signature at the end of a note or assessment. For this reason, always make sure you log 

off at the end of your session, and that you log yourself in at the beginning of each 
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session. This helps ensure that no one else can chart with your signature, or that you 

chart with someone else’s signature. 

Hide/Secure ECS Feature 
1. The Hide ECS feature gives you the chance to lock ECS on the computer you are 

working on for a short time if you need to step away from the screen (i.e., medication 

pass). This acts like a “bookmark,” keeping your place while preventing others from 

seeing the screen or logging you off. 

2. Click the Hide icon or go to American Data – ECS > Hide ECS. 

3. ‘Hide ECS’ may be set to kick in automatically during certain ECS applications (i.e., after 

30 seconds of idle time). 

4. When ‘Hide ECS’ takes effect, ECS is minimized and a screen pops up displaying the 

name of the user currently logged into that session. Only that user’s password or Delay 

Login will bring ECS back up. 

5. If the user who activated the Hide ECS feature is unavailable to log back in, the session 

must be ended by other means, such as Ctrl+Alt+Delete. The procedure may vary 

depending upon other variables, such as whether ECS is operating on thin clients or in 

a Citrix environment. This is typically worked out with the facility’s IT department. 

Exiting ECS 
1. It is important to log out of ECS whenever you will not be actively using it, to ensure 

that no other user can access it with your user profile entered.  

2. To close out of ECS, first close out of all the screens that are open. This includes any 

documentation, viewing, MDS or other screens that may be open or layered on top of 

one another. Each screen that is open is represented by a tab at the top of the screen. 

Click the X on the tab to close each tab.  

3. Click the  in the top right corner of ECS to logout or go to American Data – ECS > 

Exit. 

Selecting Clients 
• Most tasks/procedures in the clinical record are client- (or provider-) driven. Whether 

you are charting, reviewing charts, or reviewing reports, you will typically need to 

define for which client(s) you are doing so. 

• Most processes in ECS require you to select clients from a Name Selection screen to 

complete the process. 

o The client list typically defaults to a list of current active clients (except the 

business office, which includes all clients with active AR accounts, and Human 

Resources, which accesses provider records rather than client records). 

o When your user profile is set up, it may be set to show all active clients, or may 

be narrowed down to display a specific unit. 



 

 
 

800.464.9942 | www.american-data.com   4 

o Corporate clinical staff typically has access to clients from all facilities. 

 
 

Filtering the Client List 
• The client list has a Filter button at the bottom which allows you to expand or narrow 

down the list based on specific filters set on the Demographic screen. 

• For purposes of managing the client list, each client is assigned to one of 6 statuses: 

Active / Inactive / Hold / Referral / Other / Closed Account. After clicking Filter, you 

may add or remove checkmarks from the six (6) statuses to bring up the list of desired 

clients. 

• Clients may be also be categorized into six (6) filters. The first two (2) are Site and 

Service, which are defined by the location of the client on the campus. Four (4) 

additional filters are available to be used as needed by the facility. Typical settings for 

these filters include: Unit, Med Cart, Floor, CNA Assignment, but may be any filter 

needed by the facility. After clicking Filter, you may select from the filters as needed to 

narrow down your client list to those clients who share a specific filter (i.e., Unit 1). Hold 

the Ctrl button on your keyboard to select more than one filter option at a time from a 

category (i.e., Unit 1 and Unit 2). 

Using “Common” to Define the Client List 
1. The Name Selection screen has a Common button at the bottom which allows you to 

narrow down the client list based on entries in clients’ records (i.e., clients in-house on 

a certain day, clients with the same doctor, clients with the same religion, etc.). 
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2. Click the Common button. 

3. Click the Tasks button.  

4. Select the task(s) you need and click Load.  

5. Select dates (if needed) and click OK.  

6. The client list will be narrowed down to clients that meet the criteria of the common 

task. 

Selecting Clients 
1. Click the name of the client you want. 

2. To select several clients, hold the Ctrl button on your keyboard, or click the Multi 

button. Each name you click will remain highlighted. 

3. To select a whole section of clients, click the first name, hold the Shift button on the 

keyboard, and then click the last name. All names between the two will be highlighted. 

4. To select all the displayed names, click the Select All button at the bottom of the 

screen. 

Switching/Changing Clients 
1. For documentation, use the next/previous client arrows to switch to the next or 

previous client selected. When only one client is selected, click Name to select new or 

additional names. 

2. Any screen displaying a Name(s) button allows you to select different names other than 

the currently selected one(s). 
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Documentation Basics 
ECS is based on the idea that when staff enters information into a client’s record, each piece of 
information is stored into a Section of the chart (i.e., Face Sheet, Nurses Notes, Physician 
Orders) and a specific Topic within that Section (i.e., Social History, Personal Information, Lab 
Results). All the stored entries are available to other users and can be pulled together from all 
different areas for review. This design eliminates much of the duplication seen in form-based 
charting. 
 

Bringing Up a Write Screen 
1. Click the appropriate charting button on your easy access screen. For example, to 

document Behavior in Nurse Charting, click the Behavior button on the Nursing Access 

screen. 

2. The other methods are to click the Write icon or go to American Data – ECS > Write > 

Entry. 

Elements of a Documentation Screen 
1. A client(s) is selected that the entries are saved to.  

 
2. A Section and Topic are selected or defined, in which the entries are saved.  

 
3. A library of terms is displayed with a text box below the documenting screen. 

4. The documenting screen contains questions and responses pertinent to the topic 

selected. 

5. Notes and assessments are created by selecting words and phrases from the 

documenting screen and adding text as needed to build the note.  

Typing vs. Clicking 

• Overall documentation should consist of about 50-75% clicking (words/phrases from 

the library of terms), and 25-50% typing.  

• Clicking key phrases allows the documentation to pull over to MDS, Billing, and 

Reports. 

• Adding your own text/wording to elaborate on the documentation ensures the 

charting is specific and detailed. 

Late Entries 
Most documentation screens have a word “Late Entry” that can be clicked when an entry 
needs to be made for a previous shift or prior date. This word may be selected at the 
beginning or end of an entry. It prompts you to select a date which the entry is for. 
 

Defined Review 
Most documentation screens display a View screen at the bottom of the screen with data that 
is relevant to the charting being completed (i.e., Pain Assessment displays the client’s 



 

 
 

800.464.9942 | www.american-data.com   7 

Analgesic orders and recent PRN pain medication use). This View screen has all the 
capabilities of using the View icon or the View Chart button. 

Viewing Records  
A View screen allows you to view one record or multiple records at a time. It is a powerful tool 
for reviewing charts, identifying clients and risk, and finding clients with common data 
elements (i.e., wounds, falls, psychotropic meds, lack of stool output, etc.) 

1. There are several ways to pull up a View screen. From an Access screen, click the View 

Chart button.  Or, click the View icon or go to American Data – ECS > View > Entry. 

2. Select the client(s) you wish to review data for (use Filter, Common, and Select All as 

needed), and click OK. 

3. Select the Topic button to select the Section, Topic(s), or Word(s) you wish to review in 

the record(s). Or, click the Task button to select the task(s) you wish to view, and then 

click Load and OK. 

4. Click Control. Use the Filter tab to select parameters for the search (if needed), 

including date range, time range, and/or discontinued entries. 

5. Use the Look tab to display entries a certain way, including sorting by topic or in 

chronological order, lines between topics, free text highlighter, show names of initials, 

etc. 

6. Click Go to display the entries. 

7. Click any of the Client, Topic, Task or Control buttons to change the selections made. 

NOTE: You will need to click Go after changing any selections to display the new 

results. 

Reports 

General Reports 
Many of the different access screens have easy buttons linked to commonly used reports. For 
example, the Activities Access screen has a column of reports including a Birthday list and 
Attendance logs, and the ADT/Face Sheet Access screen has a column of reports including 
the Daily Census and the Room/Bed list. To view one of these reports, click the appropriate 
easy button, select the desired client(s) from the name selection list, and click OK.  To view a 
report that may not be linked to an easy button, follow the steps below: 

1. Click the Reports icon. Or, go to American Data – ECS > View > Report > General. 

2. Select the desired client(s) and click OK. The Report Selection screen appears. 

3. Select the report(s) and click OK. Or, click the Tasks button, select the task(s), and then 

click Load. 

4. Select dates, times, and users as needed. 

5. Select the Preview checkbox to see a preview of the report before it is printed. 

6. Click OK to display the preview.  

7. When previewing the report, if you wish to change any printing parameter, such as 

which clients or dates you selected, click the Control button to return to the Report 
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Selection screen and then make your change. When you click OK, the report preview 

will refresh. 

8. Select the printer icon to print, the PDF icon to save to pdf, or click Close when 

finished. 

Calendar Reports 
Several of the frequently used calendar reports are linked to easy access buttons. For 
example, the ADT/Face Sheet Access screen has a column of calendar reports including a 
Statistics calendar and a Diagnoses calendar. To view a Calendar Report, click the 
corresponding easy button, select the desired client(s) from the name selection list, and click 
OK.   
 
To view a calendar that may not be linked to an easy button, follow these steps: 

1. Click the Calendar icon. Or, go to American Data – ECS > View > Calendar. 

2. Select the desired client(s) and click OK. The Calendar Report screen appears.  

3. Click the Tasks button, select the desired task(s), then click Load. 

4. Select a date range. 

5. Click OK to preview the Calendar Report. 

6. Click the Control button to return to the calendar task setup if you want to alter clients, 

task, dates, or other options. 

7. Click the Print button to print the report. 

Editing 
Only entries displayed on a View screen can be edited.  All changes to entries are tracked by 
date, time, and user.  Entries are never completely removed from the record.  Editing rights 
vary by user group and responsibility. 

1. On a View screen, click the entry you want to edit. This is called “tagging” the entry and 

will turn the text red. If you select multiple entries, the first entry you selected will 

appear with a yellow highlight.  

2. Click the Edit button, or right-click the entry to display the editing menu. 

3. See the chart below for all editing options. 

4. Complete the Editing action as needed (all the append, new and copy-editing options 

involve adding or confirming documentation). 

5. Click Go to refresh the screen and display (or remove) changes. 

Editing Feature Function Example 

Append / Append 
All 

Information is permanently 
attached to the entry; further 
editing will not be able to be 
done to the entry except to 
discontinue 

Cosigning a student’s 
documentation 
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New A new, separate entry made in 
the same topic area 

Not typically used when editing 
department notes. Can be used to 
see where an entry was charted 

Copy An exact copy of the entry is 
made 

An entry was accidentally 
discontinued and needs to be made 
active again 

Copy One (All) to 
Other Client[s] 

An exact copy of the entry is 
made and placed in another 
resident’s chart 

An entry was accidentally made in 
the wrong resident’s chart. Use ALL 
if more than one entry was selected 

Discontinue and 
Append 

Entry is discontinued and user is 
taken to a Write screen to 
document additional notes 

An error was made in documenting 
the entry and the user would like to 
explain why the entry is being 
discontinued 

Discontinue and 
New 

Entry is discontinued, a new 
entry is made in its place 

Not typically used when editing 
department notes 

Discontinue and 
Copy 

Entry is discontinued, copy of 
entry is displayed allowing user 
to make changes to the original 
entry 

User forgot to use a button word 
when documenting and would like 
to ‘insert’ the word into the entry 

Discontinue  Entry is discontinued Not typically used when editing 
department notes 

Discontinue All All highlighted entries are 
discontinued for one client 

Not typically used when editing 
department notes 

Discontinue 
Multiple Client 
Entries 

All highlighted entries are 
discontinued for multiple clients 

Not typically used when editing 
department notes 

Skip Allows user to skip a 
highlighted entry 

Highlighted an entry that does not 
need editing 

Other Features 

Layering Screens 
1. Each screen is represented by a tab at the top of the screen.   

2. If you have more tabs open than can fit on the screen, you can use the arrow buttons 

  to bring tabs into view. Click > to scroll to the right. Click >> to move the 

screen to the furthest tab on the right. Click < to scroll to the left. Click << to move the 

screen to the furthest tab on the left (Toolbar tab). 

3. Click American Data – ECS > Window. From here, you can “tile” (side-by-side) or 

“cascade” (top-to-bottom). 

4. Each open screen must be exited prior to exiting your ECS session. 
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Internal Communication 
An internal email system for ECS users. 

• Messages can be set up to happen automatically (i.e., when it is charted that a client 

falls), or created manually by clicking words or topics to send messages to others. 

• You can access your messages by clicking the envelope icon  on the bottom 

toolbar.  This icon will be covered by a number in a red circle to indicate how many 

new messages the user has. If the user receives more than 9 new messages, the icon 

will be covered by an exclamation point in a red circle. If the user has 10 or more 

unread messages, the envelope will be covered by an exclamation point in a yellow 

circle. Users can also hover over the envelope to view the number of unread messages. 

• Unread messages are indicated by bold font. 

• To delete a message, highlight it and select Delete.  

NOTE: Deleting messages does not remove the chart entries within the record. 

• Store messages in yellow file folders by right clicking into the blank space to the left of 

the messages and selecting New Folder. The folders can be moved up and down in 

the list by using the double up and double down arrows on the bottom of the screen. 

• Use the *Memo client to create messages not specific to a resident. Select the Memo 

Section and Topic to write these messages. 

• Some messages may indicate that a co-signature is required. Edit and Append the 

entry if you are required to cosign. 

 
 


